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Chapter 1

About this Guide

This chapter describes the purpose and scope of this guide, and provides a list of complementary guides.

The following topics are covered in this chapter:

� “What this Guide Provides” on page 2

� “Related Guides” on page 2
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What this Guide Provides

This guide provides in-depth details about setting up and using the eBUS Player software application to 

control your GigE Vision or USB3 Vision compliant video transmitters (cameras) and receivers.

Related Guides

The eBUS Player User Guide is complemented by the following guides:

Table 1: Related Guides

Guide Details Consult this guide when...

eBUS Player 

Quick Start Guide 

for Windows, 

eBUS Player 

Quick Start Guide 

for OS X

Provides introductory information to 

familiarize you with eBUS Player and 

provides initial setup steps.

You are using eBUS Player for the first time and 

want information about performing common 

tasks.

Vision SDK to 

eBUS SDK 

Migration Guide

Provides information about migrating 

vision system applications from Pleora’s 

legacy Vision SDK to its new eBUS SDK. 

You are migrating an existing system that is 

based on the Vision SDK to one based on the 

eBUS SDK.

iPORT™ 

Embedded Video 

Interface User 

Guides and iPORT 

External Frame 

Grabber User 

Guides

Provide you with the information you need 

to efficiently set up and start using an 

iPORT embedded video interface or 

external frame grabber to capture images 

from a camera.

You want to add an iPORT embedded video 

interface or external frame grabber to your 

system, or want to change the configuration 

settings of an embedded video interface or 

external frame grabber that is already part of 

your system.

iPORT Advanced 

Features User 

Guide

Provides you with the information you need 

to configure Pleora’s powerful, advanced 

video interface features, which allow you to 

control and synchronize the external 

devices in your vision system solution.

You want to configure your system to trigger, 

route, time, and add data to the general purpose 

input and output (GPIO) signals that interface to 

camera heads and industrial sensors. You want 

to use the device’s Programmable Logic 

Controller (PLC).

vDisplay HDI-Pro 

External Frame 

Grabber User 

Guide

Provides you with the information you need 

to efficiently set up and start using a 

vDisplay HDI-Pro External Frame Grabber 

to transmit images to a display monitor.

You want to add a vDisplay HDI-Pro External 

Frame Grabber to your system, or want to 

change the configuration settings of a vDisplay 

HDI-Pro External Frame Grabber that is already 

part of your system.
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Chapter 2

About eBUS Player

eBUS Player, part of the Pleora Technologies eBUS™ SDK, is a sample application that allows you to 

control the parameters of GigE Vision and USB3 Vision compliant devices by providing access to the 

GenICam-compliant XML files built into all GigE Vision and USB3 Vision compliant devices. The 

XML file provides access to the GigE Vision and USB3 Vision device features, which are controlled with 

the GenICam API and a GenICam node map.

eBUS Player allows you to save GenICam XML information retrieved from a device; you can also load 

the saved GenICam XML file information to a device.

Not just a controller, eBUS Player also receives and allows you to view streaming data. While viewing the 

image data, you can use eBUS Player to balance the colors, and save video, images, and device 

configuration settings.

You can use the tools in eBUS Player to determine the optimal settings for your Vision system.

As you become more familiar with GigE Vision, USB3 Vision, and GenICam, you can continue to 

control your GigE Vision and USB3 Vision devices using eBUS Player, or you can build your own 

software application using the eBUS SDK.

The following topics are covered in this chapter:

� “Installing and Launching eBUS Player” on page 4

� “System Requirements” on page 4

� “Launching eBUS Player” on page 4

� “Working with eBUS Player” on page 5

� “GigE Vision and USB3 Vision Support” on page 5

Ensure that you have installed version 4.1 (or later) of the eBUS SDK on the computer.
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Installing and Launching eBUS Player

The eBUS Player application is installed with the eBUS SDK. Follow the installation wizard prompts to 

install the eBUS SDK on your computer. Two separate installation packages are available for the 

Windows® operating system: 32-bit and 64-bit.

System Requirements

Ensure the computer on which you install the eBUS SDK meets the following recommended 

requirements:

� At least one Gigabit Ethernet NIC (if you are using GigE Vision devices) or at least one USB 3.0 
port (if you are using USB3 Vision devices).

� One of the following operating systems:

� Microsoft® Windows 10, 32-bit or 64-bit

� Microsoft Windows 8.1, 32-bit or 64-bit

� Microsoft Windows 7 with Service Pack 1 (or later), 32-bit or 64-bit

� Windows 2008 Server with Service Pack 3 (or later), 32-bit or 64-bit

� Windows Server 2012, 64-bit

� Red Hat Enterprise Linux 7, 64-bit

� CentOS 7, 64-bit

� Ubuntu 14.04 and 16.04 LTS, 32-bit or 64-bit

If you use the Linux operating system, you must install the SDK as superuser.

Launching eBUS Player

You can launch eBUS Player from the Windows Start menu, in the Pleora Technologies Inc folder.

You can access the installation files package from the Pleora Support Center at www.pleora.com.

http://www.Pleora.com
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Working with eBUS Player

The main screen of eBUS Player consists of two main sections. You can select, connect to, and acquire 

images from your GigE Vision or USB3 Vision device using the functions in the Connection section on 

the left side of the main screen, and you can view video in the Display section on the right side of the 

main screen.

GigE Vision and USB3 Vision Support

eBUS Player provides the flexibility to communicate with both GigE Vision devices and USB3 Vision 

devices. As you work with eBUS Player, you will notice that the available options in the user interface 

vary, depending on the type of device to which eBUS Player is connected.

eBUS Player can communicate with GigE Vision devices using either a direct Ethernet connection or 

through a GigE switch. For USB3 Vision devices, eBUS Player uses a direct USB 3.0 connection.

For more detailed information about how to use eBUS Player to control your GigE Vision or USB3 Vision 

devices, please see “Controlling GigE Vision and USB3 Vision Devices” on page 15.
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Chapter 3

Choosing a Driver

This chapter describes the drivers that are available, and provides guidance on selecting the driver that is 

best suited for your system.

The following topics are covered in this chapter:

� “Comparing Drivers” on page 8

� “Using the eBUS Driver Installation Tool” on page 9
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Comparing Drivers

The eBUS SDK provides you with drivers you can install to:

� Optimize the performance of your GigE Vision system

� Connect to, control, and receive images from USB3 Vision devices

Table 2: Available Drivers

Driver Description

Manufacturer Driver Provides functionality developed by the card’s manufacturer. 

For GigE Vision systems, you can use the default network stack on your computer 

or laptop when it is not desirable or possible for you to install a driver. The network 

stack offers acceptable performance in most scenarios, but applications will 

consume greater processor resources during operation, and throughput may be 

limited.

For USB3 Vision systems, if you are using a USB3 Vision device without installing 

the USB3 Vision driver, eBUS Player will detect a USB3 Vision device, but you cannot 

connect to the device, control the device, or stream images. To perform these 

activities, you must install the USB3 Vision Driver.

GigE Vision Driver Provides the best performance and excellent compatibility with most network 

adapters. For use with GigE Vision devices.

USB3 Vision Driver Provides control and streaming capabilities. For use with USB3 Vision devices.

Note: Some USB 3.0 host controllers allow you to enable or disable power 

management. We recommend that you disable power management.

As part of the eBUS SDK installation wizard, you can choose which driver to install. Or, you can use the 

eBUS Driver Installation Tool to install or change drivers. The Driver Installation Tool can be launched 

from the Pleora Technologies Inc folder on the Windows start menu.
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Using the eBUS Driver Installation Tool

Included in the eBUS SDK is the eBUS Driver Installation Tool. You can use this tool to install or 

uninstall a Pleora driver.

To install a Pleora driver

1. Click Start > All Programs > Pleora Technologies Inc > eBUS SDK > Tools > eBUS Driver 
Installation Tool.

2. Under the driver that matches the types of devices you will connect to, click Install.

The USB3 Vision driver is installed across all USB3 Vision devices on your computer. The GigE 
Vision driver is installed across all network adapters on your computer. If you want to disable the 
driver for a particular network adapter, see “Configuring the Network Adapter” on page 10.

3. Close the eBUS Driver Installation Tool.

You may be required to restart your computer.

To see the versions of the installed drivers, click Help > About.

You can choose to install Pleora drivers as part of the eBUS SDK installation wizard, or you can use the 

eBUS Driver Installation Tool to install or uninstall a driver.
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Configuring the Network Adapter

For GigE Vision devices, you can configure your network adapter to reduce CPU utilization, and enhance 

receive and transmit performance.

In the eBUS Driver Installation Tool, click Advanced to configure your network adapter. In the Network 

Adapter Configuration dialog box that appears, you can perform the following tasks for the selected 

network adapter:

� Enable or disable the eBUS Universal Pro for Ethernet driver.

� Enable or disable jumbo packets.

� Change the number of receive and transmit buffers.

� Open the Windows Device Manager to configure additional network adapter properties or to 
configure settings that are unavailable in this dialog box.

� Open the Windows Internet Protocol version 4 Properties dialog box to configure the IP address 

and subnet.

The Network Adapter Configuration dialog box provides detailed descriptions of these settings and 

explains the impact of these settings on latency and memory consumption.

As you adjust the settings the changes are applied to the selected network adapter.



It is important to note that in most cases, you do not need to disable the computer firewall.
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Chapter 4

Configuring Firewalls to Allow Communication With 

GigE Vision Devices

Some third-party GigE Vision devices do not support the optional features introduced in version 1.1 (and 

later) of the GigE Vision standard, which ensure compatibility with firewalls. This restriction requires you 

to disable the computer firewall to properly use devices that do not support the optional features.

This chapter provides you with instructions for disabling the firewall in the Windows 8 and Windows 7 

operating systems. This chapter only applies to systems that include GigE Vision devices; it does not 

apply to systems that use USB3 Vision devices.

The following topics are covered in this chapter:

� “Pleora GigE Vision Devices Support Firewall Compatibility Features” on page 12

� “Disabling the Windows 8 Firewall” on page 13

� “Disabling the Windows 7 Firewall” on page 14

For more detailed information about how firewalls function, including how firewalls can affect GigE Vision 

devices, see the Pleora Technologies Technical Note, Correcting Firewall Issues with 3rd Party GigE Vision 

Devices, available on the Pleora Support Center at www.pleora.com.

http://www.pleora.com
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Pleora GigE Vision Devices Support Firewall Compatibility 

Features

Pleora GigE Vision devices support the firewall compatibility features introduced in version 1.1 (and 

later) of the GigE Vision standard. These features allow devices to report the device-side UDP ports they 

use for streaming and messaging channels. This reporting feature allows the SDK to know exactly where 

to send the packets that are used to keep the firewall open.

The eBUS SDK operates correctly with Windows firewalls when used with Pleora GigE Vision devices. 

You should not have to lower the firewall or take any specific action.

GigE Vision 1.0

GigE Vision 1.0 does not provide any standard device-side UDP port side reporting mechanism. 

However, because Pleora developed both the eBUS SDK and the iPORT devices, the device-side UDP 

port numbers used by the devices are known to the SDK.

When the eBUS SDK is used with a Pleora device, it knows where to send the packets to keep the firewall 

open. For streaming, the device uses port 20202 + channel number. The streaming channel 0 (first, 

default) uses port 20202. For the messaging channel, the device uses port 4.

Third-Party Devices

As mentioned previously, version 1.1 of the GigE Vision standard added optional features, allowing 

devices to report which device-side UDP port is used for streaming each available streaming channel, and 

for the messaging channel. This mechanism allows the eBUS SDK to know exactly where to send the 

packet that is used to keep the firewall open.

It is important to understand that this GigE Vision 1.1 feature is optional. Not all third-party devices 

support it, even if they report using GigE Vision 1.1 (or later).

If your third-party devices support the firewall compatibility features, your system should work without 

having to disable the firewall.

If your third-party devices do not support the firewall compatibility features, the firewall needs to be de-

activated for your system to stream, or use the messaging channel.
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Disabling the Windows 8 Firewall

The following procedure explains how to disable the Windows 8 firewall.

To disable the Windows 8 firewall

1. Open Windows Firewall by pointing to the upper-right corner of the screen, moving the mouse 
pointer down, and then clicking Search. 

2. In the search box, type firewall. 

3. Click Settings. 

4. Click Windows Firewall.

5. In the left pane, click Turn Windows Firewall on or off. You might be asked for an admin password 
or to confirm your choice.

6. Click Turn off Windows Firewall (not recommended) for the appropriate network locations.

7. Click OK.
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Disabling the Windows 7 Firewall

This section provides you with the steps to take to disable the Windows 7 firewall. In the Windows 7 

operating system, you can control the firewall setting for domain networks (corporate), home or private 

networks (behind a secured router, such as a home or SOHO network), or a public network.

We recommend that you do not deactivate the firewall on a public network, such as a wireless access point 

at a coffee house or hotel. If you are on a corporate or home network, but Windows behaves as if you are 

on a public network, you might need to set the correct type of network used by your NIC.

To set your network type

1. Click Start > Control Panel. 

2. Click Network and Internet.

3. Click Network and Sharing Center.

4. Adjust the network settings.

5. Close the Control Panel.

To disable the Windows 7 firewall

1. Click Start > Control Panel. 

2. Click System and Security.

3. Click Windows Firewall.

4. In the Control Panel Home, click Turn Windows Firewall On or Off.

5. Select Turn Off Windows Firewall for the appropriate network locations.

6. Close the Control Panel.
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Chapter 5

Controlling GigE Vision and USB3 Vision Devices

After you have assembled and powered up the GigE Vision and USB3 Vision devices in your video 

system, you can connect to and adjust the settings of the devices using eBUS Player. 

The following topics are covered in this chapter:

� “Connecting to a Device” on page 16

� “Configuring a Persistent IP Address for a GigE Vision Device” on page 18

� “Acquiring Images” on page 20

� “Adjusting Image Displays” on page 21

� “Reconstructing Images from a Multi-Tap Camera” on page 22

� “Using the Histogram Feature to Adjust the Contrast in Images and Video” on page 24

� “Displaying Chunk Data” on page 26

� “Saving Images and Video” on page 27

� “Configuring How Images are Acquired” on page 29

� “Reviewing the Acquisition Status” on page 33

� “Configuring eBUS Player as a Controller or Data Receiver” on page 34

� “Configuring the Stream Destination for GigE Vision Devices: Unicast or Multicast” on page 36

� “Accessing the Communication Settings” on page 37

� “Accessing the Device Settings” on page 38

� “Monitoring Performance” on page 45

� “Using the Event Monitor” on page 47

� “Using the Device Serial Ports” on page 48



16  eBUS Player User Guide

Connecting to a Device

When you click Select/Connect on the main page of eBUS Player, eBUS Player automatically detects:

� GigE Vision devices connected to your computer’s NIC(s) or switch 

� USB3 Vision devices connected to your computer’s USB port or hub

For GigE Vision devices, it is important for eBUS Player to be installed on a computer that is configured 

for the same subnet as the GigE Vision device to which you want to connect.

To connect to a device

1. Click Start > All Programs > Pleora Technologies Inc > eBUS SDK > eBUS Player.

2. Under Connection, click Select/Connect.

3. Click the GigE Vision or USB3 Vision device in the Available Devices list, and then click OK.

4. If you are using the manufacturer driver, a message may appear, indicating that you are not using 
an eBUS driver. Keep in mind the following information about drivers:

• GigE Vision devices. For optimal streaming performance, we recommend you use the GigE 
Vision driver.

• USB3 Vision devices. The manufacturer driver allows eBUS Player to detect USB3 Vision 
devices, but you cannot control the devices or stream images. To perform these activities, you 
must install the USB3 Vision driver.

For more information, see “Choosing a Driver” on page 7.
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If your GigE Vision device does not appear in the Available Devices list (possibly because eBUS 
Player and the GigE Vision device are not on the same subnet) you can do one of the following:

• Click Show unreachable Network Devices.

If the IP address is not valid (that is, the device is on a different subnet than the computer 
running eBUS Player), a red warning icon appears. Click Set IP Address and enter a temporary 
IP address, subnet mask, and default gateway in the Set IP Address dialog box. Click OK to 
close the Set IP Address dialog box. Please note that this information is temporary and is reset 
when you power down the device. To enter an IP address that is permanently used on the GigE 
Vision device, see “To configure a persistent IP address for a GigE Vision device” on page 18.

• If you know the IP address of the device, click Select from IP Address. In the Select From IP 
Address dialog box, type the IP address and then click OK. Please note that your device must be 
on the same subnet as the computer running eBUS Player.

Warnings and errors related to the USB3 Vision device and host controller may appear in the right-hand 

panel of the Device Selection dialog box. For example, a warning may appear if you have connected your 

USB3 Vision device to a USB 2.0 port.

5. Click OK in the Device Selection dialog box.

6. If you are connecting to a Camera Link external frame grabber, such as the CL-GigE, CL-U3, or 
CL-Ten External Frame Grabbers, you are asked how you plan to control the camera. You can do 
one of the following:

• If you are only interested in seeing the image stream and will configure camera control later, 
click I will manually configure how the camera is controlled. 

• If you already have a CL Protocol library on your computer, it will appear under I have a a CL 
Protocol library that can be used to control my camera. You can select this option to connect to 
the external frame grabber and control the camera.

• If your camera is GenCP compliant, click My camera is GenCP compliant to connect to the 
external frame grabber and control the camera.

For more information about these options, see “Establishing Communication Between a Camera 
and Third-Party Camera Configuration Software” on page 52.

7. If you are using the vDisplay HDI-Pro External Frame Grabber with your GigE Vision device, the 
first time you start eBUS Player and connect to a vDisplay HDI-Pro External Frame Grabber, the 
following message may appear. Click Yes. Roles are discussed later in this guide, in “Configuring 
eBUS Player as a Controller or Data Receiver” on page 34.

8. Now that you have connected to the device, here are some common tasks that you can perform:

• Configure a persistent IP address for the device, which will persist across power cycles, as 
outlined in “Configuring a Persistent IP Address for a GigE Vision Device” on page 18.

• Acquire images to see the image stream or the Pleora test pattern, as outlined in “Acquiring 
Images” on page 20.
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Configuring a Persistent IP Address for a GigE Vision Device

As specified by the GigE Vision standard, compliant devices are configured to automatically acquire an 

IP address using Dynamic Host Configuration Protocol (DHCP) or Link Local Addresses (LLA), 

provided no persistent IP address has been assigned. This allows you to immediately connect to the device 

at first-time deployment, and then, if you choose to, provide it with a persistent IP address. If you provide 

the device with a persistent IP address, it will use this persistent IP address each time it is powered up and 

connected to the network.

To configure a persistent IP address for a GigE Vision device 

1. Start eBUS Player and click Select/Connect.

2. Click the device in the Available Devices list.

3. Click OK in the bottom right corner.

4. Under Parameters and Controls click Device control.

5. In the TransportLayerControl section of the Device Control dialog box, enter a subnet mask in the 
GevPersistentSubnetMask box.

6. Enter a default gateway in the GevPersistentDefaultGateway box.

The subnet gateway value can remain at 0.0.0.0.

The device can use the persistent IP address each time it is powered up as long as the IP address is valid 

and there are no IP address conflicts.
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7. Click True in the GevCurrentIPConfigurationPersistentIP list.

8. Enter the persistent IP address in the GevPersistentIPAddress box.



20  eBUS Player User Guide

9. Close the Device Control dialog box.

The device uses the persistent IP address first, but if this option if set to False, it uses the IP address 

provided by DHCP next, and if this fails, uses LLA to find an available IP address. LLA cannot be disabled 

and is True by default.

Acquiring Images

Because most devices start up in a state that is ready to send images, you can start acquiring images as 

soon as you apply power and connect the transmitter to the network (for GigE Vision devices) or USB 

3.0 port on your computer (for USB3 Vision devices with the USB3 Vision driver installed). 

Pleora GigE Vision and USB3 Vision devices can transmit a test pattern, which is a test image generated 

by the device and can be used when a camera head is not available (most devices transmit a test pattern 

by default). If you have a camera head, you can turn the test pattern off to see the image stream.

To turn the test pattern on or off

1. Start eBUS Player and click Select/Connect.

2. Click the device in the Available Devices list.

3. Click OK in the bottom right corner.

4. Under Parameters and Controls, click Device control.

5. Under ImageFormatControl, click a test pattern option in the TestPattern (or TestImageSelector 
for some devices) list.

6. Close the Device Control dialog box.

To acquire images

1. Start eBUS Player and click Select/Connect.

2. Click the device in the Available Devices list.

3. Click OK in the bottom right corner.

4. For multi-source GigE Vision devices, click the source to which a camera is connected under 
Source. If you do not have a camera connected, you can use the test pattern. For more information, 
see “To turn the test pattern on or off ” on page 20.

5. In the Mode list, click Continuous, which configures the device to send a stream of continuous 
images (instead of a single image).

For other acquisition modes, see “Configuring How Images are Acquired” on page 29.

6. Click Play.

If you are using eBUS Player to connect to a vDisplay HDI-Pro External Frame Grabber, this section does not 

apply. A vDisplay HDI-Pro External Frame Grabber acts as a controller and/or receiver, which means that it 

does not transmit video over the network. Instead, skip this section and go to “Configuring eBUS Player as 

a Controller or Data Receiver” on page 34.
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The images appear in the Display section. 

Some of the core GenICam commands are executed when you click buttons and make selections in the 

Player window. For example, when you click Play or Stop and you are working with a GigE Vision device, the 

AcquisitionStart and AcquisitionStop commands are executed. When you select a source for a multi-

source GigE Vision device, the GevStreamChannelSelector feature is accessed.

We recommend that you do not use the AcquisitionStart and AcquisitionStop features in the Device 

Control dialog to start and stop streaming. Instead, you should use the Play and Stop buttons in the Player 

window.

Adjusting Image Displays

eBUS Player provides you with tools to adjust your images.

To adjust the display frame rate

� On the Tools menu, click Display and then click a display rate. 

- Or - 

Click Disabled to turn off the display of images. This can be useful when benchmarking the 
performance of the eBUS SDK.

To zoom the image in or out

� Right-click the image and click a zoom setting.

To use RGB filtering to adjust the image color

1. On the Tools menu, click Image Filtering.

2. Under RGB Filtering, select the Enabled check box.

3. Adjust the image color. 

Gains are multipliers for all R, G, and/or B color values. Offsets are values that are added to all R, 
G, and/or B color values.

Clicking White Balance adjusts the gains so that the last acquired image is balanced to average gray.

As you make adjustments, the image is updated in the Display section.

4. Close the dialog box when your adjustments are complete.



22  eBUS Player User Guide

To change Bayer interpolation to display images

1. On the Tools menu, click Image Filtering.

2. Under Bayer Interpolation, click an interpolation method to display images: Simple (2 x 2) or 
Interpolation (3 x 3).

3. Close the dialog box.

Reconstructing Images from a Multi-Tap Camera

For multi-tap cameras, pixels may not be received in order from the camera, depending on its tap 

geometry. Using the tap reconstruction option in eBUS Player 4.1.5 (or later), you can specify the tap 

geometry that corresponds to your camera, which allows the eBUS SDK to reconstruct the image before 

it appears on your display and before it is saved in image or MP4 format.

Some Pleora devices, perform reconstruction for selected tap geometries, allowing the image to be 

reconstructed before it is transmitted. For more information, see the user guide that accompanies your 

Pleora device.

A variety of tap geometries can be reconstructed using eBUS Player. For descriptions of the tap geometries, 

see the GenICam Standard Features Naming Convention (SFNC), available from the European Machine 

Vision Association at www.emva.org.

http://www.emva.org
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To reconstruct the pixels from a multi-tap camera

1. On the Tools menu, click Image Filtering.

2. Under Tap Reconstruction, select a tap configuration.

The change is applied immediately and the image updates (if it is already playing in eBUS Player).
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Using the Histogram Feature to Adjust the Contrast in Images 

and Video

For pixel formats that have more than 8 bits per component, the least significant bits (LSB) are not shown 

in the eBUS Player display. Depending on your image, this may make it difficult to see objects in the 

camera’s field of view clearly. In release 4.1.4 (and later), you can use the histogram feature to increase the 

contrast of images that are displayed in eBUS Player or exported as H.264 video. This can help make the 

image or video clearer.

The histogram shows the number of pixels with the pixel value and the range of colors.

Darkest portion
of the image

Number of pixels
with this value

Lightest portion
of the image
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By adjusting the Light and Dark sliders, you can constrain the pixel values used for display.

To adjust the contrast of images displayed in eBUS Player or exported as H.264 video

1. On the Tools menu, click Image Filtering.

2. Under Histogram, select the Enabled check box.
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3. Do one of the following:

• Move the Dark and Light sliders to constrain the pixel values that are used for display.

• Click the Auto Configure button to move the sliders to the lightest and darkest points on the 
histogram.

Displaying Chunk Data

You can choose to overlay chunk data as text on top of images in the Display section. Chunk data is often 

used to provide the status of external devices at the moment that the image was captured. The ability to 

overlay chunk data on images is available for devices that are compatible with version 2.0 (and later) of 

the GigE Vision standard or version 1.0 (and later) of the USB3 Vision standard.

Examples of chunk data

In a quality inspection system where a rotary encoder (or shaft encoder) is used on a conveyor belt, chunk 

data can include the position of the conveyor belt at the moment that the image was captured or a count 

of position changes.

For systems that pre-process images, such as systems that perform edge detection, chunk data can 

include the result of the pre-processing operation (for example, chunk data can indicate where the edges 

are).

To use this feature, your GigE Vision or USB3 Vision device must be configured for chunk data. For more 

information, see the documentation accompanying your device. For detailed information about the 

extended chunk mode feature, see the iPORT Advanced Features User Guide, available on the Pleora 

Support Center at www.pleora.com.

http://www.pleora.com
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To display chunk data

� On the Tools menu, click Display Chunk Data.

If the chunk data consists of printable characters, it is overlaid on top of the image.

Chunk data is overlaid on top of the image in eBUS Player.

Saving Images and Video

eBUS Player allows you to save acquired images in image format (BMP, TIFF, or raw binary format) or 

MP4 video format.

To save images and video periodically

On the Linux operating system the H.264 encoding feature is not enabled by default. You must install the 

following external libraries: libswscale and libav. After the libraries are installed, enable the PV_ENABLE_MP4 

preprocessor in the eBUSPlayerShared project and recompile eBUS Player.

MP4 recording is not available on the Windows XP operating system.

1. On the Tools menu, click Save Images or Video.

2. Select the Enable Image or Video Saving check box.

3. Click the browse button to select a location to save image or video files, and then click OK.

4. In the Format list, click the format in which you want to save images:

• Image format, converted to RGB before saving:

• Device independent bitmap (BMP)

• Image format, saved without any conversion:

• Tagged Image File Format (TIFF)

• Raw binary data

• Video format:

• H.264 video in MP4 container

5. If you selected H.264 video in MP4 container in step 4, specify the data rate of the video file in the 
Target encoding bitrate box.

If you adjusted the contrast of the images using the eBUS SDK histogram feature, please note the following:

� Image format. The adjusted contrast is not used for the image files that you save. Images are saved 

without any modification, which is beneficial if you are performing image processing.

� MP4 video format. The adjusted contrast is used for video that you save, which can provide greater 

clarity.
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6. Under Throttling options, specify when you want to save images. Images are saved in image format 
or MP4 video format in the location specified in 3.

• Save one image out of every [ ] captured images.

• Save a maximum of one image every [ ] ms. The display thread saves an image if at least X ms 
has elapsed since the last image was saved.

• Throttle throughput to HDD. Maintain [ ] Mbits/s average. The throughput of saved images 
is monitored to stay as close to X Mbits/s as possible.

• No throttling (Limited by CPU, HDD, etc. Images may be dropped). The display thread 
attempts to save every image.

7. Click OK.

The Display section changes to red, the word RECORDING appears, and statistics about the 
recording appear, including the image count, the size of the file, the frame rate, and the data rate.

The file name of the saved image or video files contains an internal counter, the image timestamp, 
and the system tick count.

If you are displaying chunk data, only the image is saved (because the chunk data is overlaid on top of the 

image, it is not part of the image or video).

If you are saving images in MP4 format and have selected the Save one image out of every [ ] captured 

images, stopping recording before the entire image has been stored in the file will result in an incomplete 

MP4 file that cannot be played.

To save the current image

� On the Tools menu, click Save Current Image. 

By default, the image is saved as a bitmap file in your Pictures library. To change the file type or 
location, see “To change the location and format in which the current image is saved”, below.

Please note that Save Current Image saves BMP, TIFF, or raw binary data, not MP4 video.

To change the location and format in which the current image is saved

1. On the Tools menu, click Save Images or Video.

2. Select the Enable Image Saving check box.

3. Click the browse button to select a location to save images, and then click OK.

4. In the Format list, click the format in which you want to save images:

• Device Independent bitmap (BMP)

• Tagged Image File Format (TIFF)

• Raw binary data

If you adjusted the contrast of images using the eBUS SDK histogram feature, please note that the adjusted 

contrast is not used for the image that you save. Images are saved without any modification, which is 

beneficial if you are performing image processing.
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5. You do not need to change the Throttling options, as only a single image will be saved.

6. Click OK.

Note: When you close and re-open eBUS Player, the default image format and save folder are used.

Configuring How Images are Acquired

Depending on the device you use, eBUS Player provides you with a list of image acquisition modes. The 

modes allow you to acquire images continuously or frame-by-frame. You can also save images to the 

device’s onboard memory so that you can retrieve them later.

Modes Standard on Most GigE Vision and USB3 Vision Compliant Devices

Continuous, SingleFrame, and MultiFrame modes are usually standard for devices. Acquisition starts 

when the Play button is pressed (the AcquisitionStart command is executed).

Continuous Mode

This mode allows you to acquire images continuously and is the default mode for most devices.

SingleFrame Mode

This mode allows you to acquire a single image. 

The acquisition modes supported by a device are enumerated by the GenApi AcquisitionMode feature.
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MultiFrame Mode

This mode allows you to acquire a fixed number of images. To configure the number of images, set the 

device’s AcquisitionControl > AcquisitionFrameCount feature.

You can set the AcquisitionControl > AcquisitionFrameCount feature in the Device Control dialog box, 

as shown in the following image.

Recording and Readout Modes, Available on Pleora Devices

The recording acquisition modes allow you to capture images from a camera and store them in the Pleora 

device’s onboard memory. The readout acquisition modes allow images to be acquired from the device’s 

memory at a slower rate, ensuring images are not lost. 

These modes are helpful when you are working with a camera that transmits images at a rate that exceeds 

the connection between the Pleora device and the computer, resulting in dropped images. By using the 

recording and readout modes, you can capture and stream images from the camera without losing any 

images (as long as there is space in the onboard memory).

The recording acquisition modes (ContinuousRecording, MultiFrameRecording, and 

SingleFrameRecording) support back-to-back recording, which allows you to click the Stop and Play 

buttons multiple consecutive times without clearing the onboard memory.

Acquisition starts when the Play button is pressed (the AcquisitionStart command is executed) when one 

of the recording modes is selected.

Images can be stored in the device’s onboard memory as long as there is space or until there are 512 images 

in memory. For information about calculating how many images you can store, see “Calculating How 

Many Images Can be Stored in Onboard Memory” on page 33 .
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Understanding When Images are Removed from the Onboard Memory

The following actions remove the images from the device’s onboard memory:

� Streaming images from the onboard memory using one of the readout acquisition modes 
(ContinuousReadout or SingleFrameReadout).

� Power cycling the device, which clears all images from the onboard memory.

� Making any of the following AcquisitionMode changes and then clicking the Play button 
(AcquisitionStart command):

Table 3: Changes that Clear Images from the Onboard Memory

First you acquire images with... And then you change the Acquisition mode to...

ContinuousRecording, MultiFrameRecording, or 

SingleFrameRecording

Continuous, MultiFrame, or SingleFrame

SingleFrameReadout or ContinuousReadout SingleFrame, MultiFrame, or Continuous

SingleFrameReadout or ContinuousReadout ContinuousRecording, MultiFrameRecording, or 

SingleFrameRecording
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ContinuousRecording Mode

With this mode, images are acquired continuously and are stored in the device’s onboard memory until 

the memory is full (or 512 images are stored in onboard memory). When this limit is reached, the Pleora 

device stops acquiring new images from the camera. 

We recommend that you observe AcquisitionControl > BlockBufferCount (Expert or Guru visibility 

level is required). When the value for this feature stops increasing, the memory is full. For information 

about the actions that clear the images from onboard memory, see “Understanding When Images are 

Removed from the Onboard Memory” on page 31.

ContinuousReadout Mode

With this mode, images are continuously read (and removed) from the device’s onboard memory. The 

readout begins at the first image in memory. To see the number of images stored in onboard memory, see 

AcquisitionControl > BlockBufferCount in the Device Control dialog box (Expert or Guru visibility 

level is required). 

Readout continues until the Stop button is pressed (AcquisitionStop command is executed) or until the 

last image has been sent by the device (BlockBufferCount will be 0).

MultiFrameRecording Mode

With this mode, a fixed number of images are stored in the device’s onboard memory. To configure the 

number of images, set the AcquisitionControl > AcquisitionFrameCount feature in the Device Control 

dialog box. Images can be read out from memory using ContinuousReadout mode.

If AcquisitionControl > AcquisitionFrameCount is set to a value that exceeds the amount of available 

memory, the  Pleora device stops acquiring new images when the onboard memory is full (or 512 images 

are stored in onboard memory).

BlockBufferCount shows the number of images currently in memory. In MultiFrameRecording mode, 

this number is cumulative: If the memory is empty and you acquire an image, BlockBufferCount will 

match the AcquisitionFrameCount. If you stop and restart recording, BlockBufferCount will increment 

(to a maximum of 512 images, depending on the image size) and will no longer match the 

AcquisitionFrameCount.

For information about the actions that clear the images from onboard memory, see “Understanding 

When Images are Removed from the Onboard Memory” on page 31.

To determine how many images can be stored in memory, see  “Calculating How Many Images Can be 

Stored in Onboard Memory” on page 33.

A maximum of 512 images can be acquired at one time in MultiFrameRecording mode.

To determine how many images can be stored in memory, see “Calculating How Many Images Can be 

Stored in Onboard Memory” on page 33.
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SingleFrameRecording Mode

With this mode, a single image is saved in the device’s onboard memory after each AcquisitionStart 

command.

For information about the actions that clear the images from onboard memory, see  “Understanding 

When Images are Removed from the Onboard Memory” on page 31.

SingleFrameReadout Mode

With this mode, a single image is acquired from the device’s onboard memory.

Calculating How Many Images Can be Stored in Onboard Memory

For the recording modes, you can calculate the size of each image to determine how many images can be 

stored in onboard memory.

First, take note of the PayloadSize, which appears under TransportLayerControl in the Device Control 

dialog box. Expert or Guru visibility level is required to access this feature.

The PayloadSize is automatically calculated by the device based on the selected image settings, which 

include Width, Height, OffsetX, OffsetY, PixelSize, any chunk data, as well as any padding that has to be 

added to the image payload.

For example, for a device configured to use Mono10p with images that are 1920 x 1080, the PayloadSize 

is equal to 2 592 000 bytes per image or 2 472 MB (2 592 000 / 1 048 576).

After determining PayloadSize, you can use the following equation to determine the number of images 

that can be saved in onboard memory:

Available onboard memory MB / PayloadSize MB = Number of images that can be saved

Using our example, the equation is:

120 MB / 2 472 MB = 48 images

Reviewing the Acquisition Status

During image acquisition, information about the stream appears under the image, in addition to any 

errors or warnings that have occurred.

In most cases, errors will not appear if you are connecting to a device for the first time. If an error appears, 

click Image stream control and review the information in the Counters section. If anything other than 

zero appears in the features within this section and you are using a GigE Vision device, consult the Stream 

Control Technical Note, available at the Pleora Support Center, to determine which feature is causing the 

error and for guidance on how to correct the error.



Table 4: Roles  

Role Description

Controller and Data Receiver Select this role if you are using eBUS Player to connect to and control a GigE Vision 

or USB3 Vision transmitter AND if you want eBUS Player to receive streaming video 

from the transmitter.

This setting is ideal when you want to control an iPORT device and see streaming 

video with eBUS Player. This is the default setting.

Controller Select this role if you are using eBUS Player to connect to and control a GigE Vision 

or USB3 Vision device. eBUS Player does not receive streaming video from the 

device if this option is selected. 

This setting is often used to connect eBUS Player to a receiver, such as the Pleora 

vDisplay HDI-Pro External Frame Grabber (for use with GigE Vision devices).

Data Receiver Select this role if you are using eBUS Player to connect to and receive streaming 

video from a GigE Vision or USB3 Vision device. You cannot control the device if this 

option is selected.

The vDisplay HDI-Pro External Frame Grabber receives video from the GigE Vision network and makes it 

available for display on an attached monitor.
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Configuring eBUS Player as a Controller or Data Receiver

Depending on your system, you may need to configure the eBUS Player role, which lets you specify 

whether you want to use eBUS Player to control a GigE Vision or USB3 Vision device, or receive images, 

or simply connect to a device to view its parameters and settings. The following roles are available:
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To configure eBUS Player as a controller or data receiver

1. Start eBUS Player and select Setup on the Tools menu.

2. Select a role.

3. For multi-channel GigE Vision devices, select the default channel under Stream Channel.

For multi-channel GigE Vision devices, eBUS Player queries the GenICam interface of the device (in most 

cases) to determine which channel should be used with the source. In cases where eBUS Player cannot 

determine the channel to use, the default channel that you specify is used. This can occur when you are 

using a data receiver that does not have access to device control. If you are multicasting and want to set 

up a pure data receiver, you need to specify the channel on which to listen by typing the Default channel.

4. Click OK.

If eBUS Player is already connected to a device, you must close the Setup dialog box and disconnect from 

the device before you can select an eBUS Player role.
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Configuring the Stream Destination for GigE Vision Devices: 

Unicast or Multicast

You can configure a GigE Vision stream destination to send images to a single location or to multiple 

locations.

Table 5: GigE Vision Stream Destination Options  

Option Description

Unicast, automatic Select this option to configure the camera to stream video directly to the eBUS Player 

computer using an automatically-selected port.

Unicast, specific local port Select this option to configure the camera to stream video directly to a user-defined 

port on the eBUS Player computer.

Unicast, other destination Select this option to configure the camera to stream video directly to a computer or a 

vDisplay External Frame Grabber (a destination other than the eBUS Player computer).

Multicast Select this option to configure the camera to join a multicast group (specified by the 

IP address and port), and to begin streaming to that group. 

The vDisplay External Frame Grabber or any other receiver (such as a computer), must 

be configured to receive streaming video at the same multicast address.

If eBUS Player is configured as a multicast receiver, it allows you to view video from the 

camera streaming video to the same multicast address.
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Accessing the Communication Settings

You can access the communication settings to adjust how the host computer connects to, and 

communicates with, GigE Vision or USB3 Vision devices.

Before you connect to a GigE Vision or USB3 Vision device, you can set the default communication 

parameters that will be used for the connection. If the connection is already established, you can adjust 

the communication settings as required.

To set the default communication parameters for the initial device connection

1. Start eBUS Player.

2. On the Tools menu, click Default GigE Vision Communication Parameters or Default USB3 
Vision Communication Parameters.

The Default GigE Vision Communication Parameters or Default USB3 Vision Communication 
Parameters dialog box appears.

3. Customize the communication settings as required and then close the dialog box.

When you connect to the GigE Vision or USB3 Vision device, the communication settings that 
you specified will be used. For information about connecting to a device, see “To connect to a 
device” on page 16.

To change the communication settings

1. Start eBUS Player and click Select/Connect.

2. Click the GigE Vision or USB3 Vision device in the Available Devices list.

3. Click OK in the bottom right corner.
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4. Under Parameters and Controls, click Communication control.

5. The Communication Control dialog box appears. Customize the communication settings as 
required by adjusting the features in the dialog box.

The Communication control button is only available when eBUS Player is connected to a device. To 

configure the communication settings before a connection is established with a GigE Vision or USB3 Vision 

device, see “To set the default communication parameters for the initial device connection” on page 37.

Accessing the Device Settings

To change the device settings, you can access the eBUS Player Device Control dialog box. This dialog box 

lets you specify the settings related to your device, including transport layer settings, image processing 

settings, image mode and formatting settings, display timing settings, channel settings, autonomous 

control settings, and messaging settings.

By changing the values of controls in the eBUS Player control dialog boxes, you can change how the GigE 

Vision or USB3 Vision device (and connection between the device and the host computer) performs.

System configuration is comprised of the following three categories, and provides a set of controls for each 

category in a separate dialog box:

� Communication Control dialog box. Controls connection and communication settings between 
the host computer and the GigE Vision or USB3 Vision device. For information about the 
communication settings, see “Accessing the Communication Settings” on page 37.

� Device Control dialog box. Controls all device settings, including transport layer settings, image 
processing settings, image mode and formatting settings, display timing settings, channel settings, 
autonomous control settings, and messaging settings.

� Image Stream Control dialog box. Controls image stream settings and provides performance 
statistics.

We recommend that you do not use the AcquisitionStart and AcquisitionStop features in the Device 

Control dialog to start and stop streaming. Instead, you should use the Play and Stop buttons in the Player 

window.

While the available communication control and stream control features do not change based on device, 

the available device control features are retrieved from the device’s XML file. The device control features 

will vary depending on the device you are working with.
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Connection Section

The following table shows the relationship between the controls in the Device Control dialog box and the 

controls in the Connection section.

Table 6: Connection Section Controls and Features

Connection section control Corresponding feature 

IP address field (GigE Vision devices 

only)

Device Control dialog box > TransportLayerControl / 

GevCurrentIPAddress

MAC address field (GigE Vision devices 

only)

Device Control dialog box > TransportLayerControl / 

GevMACAddress

GUID field (USB3 Vision devices only) Communication Control dialog box > Connection / DeviceGUID (not 

shown below)

Vendor field Device Control dialog box > DeviceControl / DeviceVendorName (not 

shown below)

Model field Device Control dialog box > DeviceControl / DeviceModelName (not 

shown below)
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Acquisition Control Section

The following table shows the relationship between the controls in the Device Control dialog box and the 

controls in the Acquisition Control section.

Table 7: Acquisition Control Section Controls and Features

Acquisition Control section control Feature in the Device Control dialog box

Source list (for multi-source GigE Vision devices) TransportLayerControl / GevStreamChannelSelector

Mode list AquisitionControl / AcquisitionMode

Play button AquisitionControl / AcquisitionStart (GigE Vision 

devices only)

Stop button AquisitionControl / AcquisitionStop (GigE Vision 

devices only)

If you use the AcquisitionStart and AcquisitionStop features in the Device Control dialog box to start and 

stop streaming from a GigE Vision device, please note that the TLParamsLocked feature is not activated, 

allowing you to change features that are normally locked during image streaming, such as width and height. 

This may cause unexpected results. Whenever possible, we recommend that you use the Play and Stop 

buttons to start and stop streaming.
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Display Section

The following table shows the relationship between the information in the Device Control dialog box and 

the controls in the Display section.

For transmitters that do not timestamp packets, an asterisk (*) appears next to the frame rate (FPS) and 

data rate (Mbps) in the Display section, which indicates that these values could not be calculated. You 

can set the SDK to use the receiving computer’s time to do the calculation by clicking Image Stream 

Control and setting the Statistics > General >TimestampSourcePreferred feature to Software.

Table 8: Display Section Controls and Features

Display section information Feature in the Image Stream Control dialog box

Image count (nnn images) Statistics / General / BlockCount

Frame rate (xxx FPS) Statistics / General / AcquisitionRateAverage

Data rate (yyy Mbps) Statistics / General / BandwidthAverage
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To change the device settings

1. Start eBUS Player and click Select/Connect.

2. Click a GigE Vision or USB3 Vision device in the Available Devices list.

3. Click OK in the bottom right corner.

4. Under Parameters and Controls, click Device control.

The Device Control dialog box appears. Customize the settings as required by adjusting the features 
in the dialog box.

Features that are light blue are dependent on features that are dark blue (selectors) in eBUS Player. For 

example, the UserSetLoad feature depends on the option that is selected in the UserSetSelector. If 

Default is selected, the default User Set is loaded when this command is executed. If UserSet1 is selected, 

User Set 1 is loaded. 
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Light blue feature, example

Dark blue (selector) feature, example
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To adjust the display of features

� Use the options listed in the following table when working with features.

Table 9: Adjusting the Display of Features  

Adjustment tool Description

Expand All button Expands the categories (when the Tree view is selected in the Browser Options  dialog 

box).

Collapse All button Collapses the categories (when the Tree view is selected in the Browser Options  dialog 

box).

Visibility list Filters the list of features to suit your level of video network responsibility and 

understanding. There are more controls available for the Guru level than the Beginner 

level; some controls are not available in the Beginner level.

Browser Options 

button

Opens the Browser Options dialog box, which allows you to:

� Choose whether the features are displayed as an alphabetical list or a feature tree.

� Show the features using either the feature name or the display name.

� Specify whether the device features are refreshed automatically, based on polling 

time (as defined in the GenApi XML file that was used to build the node map), or 

manually refreshed (using the Refresh button).

Expand All, 

Minus button

Plus button

Browser Options
button

Collapse All buttons Visibility list

Refresh button

Device Control Dialog Box

Browser Options Dialog Box



45Controlling GigE Vision and USB3 Vision Devices

Monitoring Performance

As your device receives images from your camera and sends them to your computer, it keeps track of 

image errors (such as missing lines), network errors (such as lost packets), and other performance-related 

statistics.

You can view a complete list of error counts in the Image Stream Control dialog box. Performance metrics 

are grouped under Statistics.

You can view a summarized list of error counts at the bottom of the Display section. The Display section 

shows the total number of images displayed (BlockCount), the instantaneous frame rate 

(AcquisitionRateAverage), and the data rate (BandwidthAverage).

Refresh button Refreshes the features of a GigE Vision or USB3 Vision device (such as a transmitter or 

receiver) that are displayed in the Device Control dialog box. The following refresh options 

are available in the Browser Options dialog box:

� Polling. Features that are defined for polling are automatically refreshed (if the 

polling time configured for the feature has elapsed).

� Automatic. The features are automatically refreshed every few seconds. This is the 

default setting. 

� Manual. You can manually refresh the features in the Device Control dialog box.

Minus button Collapses a category (when the Tree view is selected in the Browser Options dialog box).

Plus button Expands a category (when the Tree view is selected in the Browser Options dialog box).

Table 9: Adjusting the Display of Features  (Continued)

Adjustment tool Description
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For transmitters that do not timestamp packets, an asterisk (*) appears next to the frame rate (FPS) and 

data rate (Mbps) in the Display section, to indicate that these values are not available. In this case, the 

SDK uses the receiving computer’s time to calculate the values. You can change this behavior by clicking 

Image Stream Control and changing the Statistics > General >TimeStampSourcePreferred feature.
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Using the Event Monitor

The Event Monitor is a valuable tool that you can use to determine causes of issues that may occur during 

the use of your device. When enabled, you can view time-stamped records of all GenICam parameter 

updates and PvStream buffer errors, as well as the successful PvStream buffers.

You can clear the log content, and you can save the content to your hard drive.

To access the Event Monitor

1. Start eBUS Player and connect to the device.

2. Click Play.

3. On the Tools menu, click Event Monitor.

4. Select the information that you want to display in the Event Monitor:

• GenICam parameter updates. Reports all device GenICam parameter invalidation events (as 
triggered by GenApi) as event monitor log events.

• Messaging channel events. Reports all GigE Vision or USB3 Vision events to the Event 
Monitor before they are raised as GenICam parameter invalidation events. Please note that a 
large number of events will appear.

• Buffer errors. Reports all buffers retrieved from the PvPipeline by the application display thread 
that have an operation result other than OK.

• All buffer events. Reports all buffers retrieved from the PvPipeline by the application display 
thread, regardless of the operation result. Please note that a large number of events will appear.

• eBUS SDK log events. Reports interactions between the eBUS SDK (including eBUS Player) 
and the device. For example, when you start or stop a stream you will see a log event.

• Device serial communication. Reports transmit and receive information when transmitting 
serial data to a Camera Link camera. For example, information related to starting or stopping 
the stream, requests for parameter values, and data that is sent through the Device Serial 
Communication dialog box.
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To save events in the monitor

� In the Event Monitor, select the Save to file check box, browse to the desired location.

Future events will be saved to a file on your computer.

Using the Device Serial Ports

If you have a thorough understanding of the serial protocol to be used, you can communicate with a 

camera or other external devices through serial ports connected to your Pleora device.

eBUS Player allows you to control the serial ports of a GigE Vision or USB3 Vision device that is 

integrated with a Pleora device. You can also transfer files to the device using the serial port, such as a 

Non-Uniformity Correction (NUC) file, a Look-Up Table (LUT), or camera firmware.

Configuring the Serial Ports

The controls to configure the serial ports are available in the Device Control dialog box, as shown in the 

following image.

The available serial ports vary, depending on the device you are using.
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Setting the Baud Rate for Serial Ports

You must set the baud rate for the serial ports if the default value is not acceptable.

To set the baud rate for serial ports

1. Start eBUS Player and connect to your camera.

2. Click the Device control button to open the Device Control dialog box.

3. Scroll to the IP Engine > PortCommunication section.

Ensure you are using the Guru visibility level.

4. Depending on the type of device you are controlling, do one of the following:

• In the Uart0 section, set the baud rate using the Uart0BaudRate control.

• In the Uart1 section, set the baud rate using the Uart1BaudRate control.

• In the PortCommunication section, set the baud rate using the BulkBaudRate control.

Other settings, such as parity and the number of stop bits, should also be configured by entering the 

appropriate values for the settings in the PortCommunication section.
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To communicate with a camera or other external device using a serial port

1. Start eBUS Player.

2. On the Tools menu, click Device Serial Communication.

3. In the Port Selection list, click a serial or bulk port, depending on your device.
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4. Under Send as, select the data transmission sequence format by clicking either ASCII (text only) or 
Hexadecimal.

5. Type the data string in the Data box.

For hexadecimal, enter a pair of hexadecimal digits for each byte, separated by spaces. For example, 
01 23 45 67 89 AB CD EF.

6. Select one of the trailer options beside Append.

Trailer options are not mutually exclusive; they append in the order shown.

Select Other for ASCII and hexadecimal sequences in custom trailers for devices that do not use the 
trailer options in the order shown, for example, CR and LF.

7. Click Send to transmit the data sequence.

8. Wait for the device to reply.

9. Close the Device Serial Communication dialog box.
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Establishing Communication Between a Camera and Third-

Party Camera Configuration Software

In some systems, you may be required to use an existing third-party camera configuration application (for 

example, the software application that was provided with the camera), a third-party application relying 

on a Camera Link DLL, or a Camera Link camera that has a CLProtocol DLL. In each of these cases, the 

system requires that applications send serial commands to a camera through a Pleora video interface, such 

as an embedded video interface or external frame grabber. Pleora’s eBUS SDK contains functionality that 

allows you to establish a bridge to facilitate communication between the eBUS SDK and a camera.

For information about establishing a communication bridge, see one of the following knowledge base 

articles on the Pleora Support Center (https://supportcenter.pleora.com).

� Knowledge Base Article: Establishing a Serial Bridge through Camera Link DLL Communication. This 
article is for users who have a third-party camera configuration application that requires that them 
use a Camera Link DLL to send serial commands to the camera.

� Knowledge Base Article: Establishing a Serial Bridge through a Serial Port (COM Port) Link. This 
article is for users who have a third-party camera configuration application and want to use a serial 
port on their computer to send serial commands to the camera, or would like to use a joystick 
connected to a serial port on their computer to control the camera.

� Knowledge Base Article: Establishing a Camera Bridge with a CLProtocol DLL and GenICam 
CLProtocol. This article is for users who have a CLProtocol DLL (provided by the camera 
manufacturer) that allows them to configure and monitor settings within the camera using 
GenICam.

� Knowledge Base Article: Establishing a Camera Bridge through GenCP. This article is for users with a 
camera that supports the GenCP device control protocol.

https://supportcenter.pleora.com/s/article/Establishing-a-Serial-Bridge-through-Camera-Link-DLL-Communication-KBase
https://supportcenter.pleora.com
https://supportcenter.pleora.com/s/article/Establishing-a-Serial-Bridge-through-a-Serial-Port-Link-KBase
https://supportcenter.pleora.com/s/article/Establishing-a-Camera-Bridge-with-a-CLProtocol-DLL-and-GenICam-CLProtocol-KBase
https://supportcenter.pleora.com/s/article/Establishing-a-Camera-Bridge-with-a-CLProtocol-DLL-and-GenICam-CLProtocol-KBase
https://supportcenter.pleora.com/s/article/Establishing-a-Serial-Bridge-through-GenCP-KBase
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Chapter 6

Saving eBUS Player and Device Settings

There are several options to save eBUS Player and device settings:

� Save current session settings to a configuration file. Save the eBUS Player preferences and device 
settings to a configuration file, which you can use to start a new session or load during future 
sessions.

� eBUS Player preferences only. Save the eBUS Player preferences, such as the frame rate used to 
display video in eBUS Player, as your default eBUS Player settings. This method also saves the 
Communication control settings, which are used to communicate with your device, such as a 
specific default heartbeat interval and answer timeout value.

� Device settings. Save the settings to the device’s flash memory as a User Set, allowing the device 
settings to persist over power cycles.

A supplementary document is available on the Pleora Support Center that lists the settings that are saved 

with each of the options listed in this chapter. For more information, see Saving eBUS Player and Device 

Settings.

The following topics are covered in this chapter:

� “Saving Your eBUS Player and Device Settings to a Configuration File” on page 54

� “Saving Your eBUS Player Preferences” on page 55

� “Saving Your Device Configuration Settings to the Device’s Flash Memory” on page 55

https://supportcenter.pleora.com/s/article/Saving-eBUS-Player-and-Device-Settings-KBase?tabset-0be0b=1
https://supportcenter.pleora.com/s/article/Saving-eBUS-Player-and-Device-Settings-KBase?tabset-0be0b=1
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Saving Your eBUS Player and Device Settings to a 

Configuration File

If you want to save the eBUS Player and device settings for a particular device, you can create a 

configuration file, which you can load during future sessions.

When you save your settings to a configuration file, all of the eBUS Player preferences, Communication 

Control settings, Image Stream Control settings, and device settings (for the particular device) are saved.

To save your eBUS Player and device settings to a configuration file

1. On the File menu, click Save.

2. Select the location in which you want to save the configuration file.

To load eBUS Player and device configuration settings from a configuration file

1. On the File menu, click Open.

2. Select the configuration file that you want to open.

If eBUS Player is not connected to a GigE Vision or USB3 Vision device, eBUS Player opens the file 
and attempts to connect to the device from which the configuration file was created. Please note, 
eBUS Player attempts to establish a connection based on the MAC address or USB 3.0 GUID of 
the device. For GigE Vision devices, using the MAC address (instead of the IP address) allows eBUS 
Player to connect to the device even if its IP address has changed.

If eBUS Player is connected to a GigE Vision or USB3 Vision device, a message appears to warn you 
that the settings will be applied to the device. Click Yes to apply the settings that are stored in the 
configuration file, or No to cancel the operation (and then disconnect from the device and connect 
to a different device).
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Saving Your eBUS Player Preferences

eBUS Player allows you to save the eBUS Player preferences as your default eBUS Player settings. This 

feature is useful when you prefer certain settings, for example you like to use a high frame rate to display 

video in eBUS Player. It is also useful if you use Communication control settings to communicate with 

your GigE Vision or USB3 Vision devices, such as a specific heartbeat interval and answer timeout value. 

If you want to revert back to the original eBUS Player default preferences, you can do so at any time.

To save your eBUS Player preferences

� On the eBUS Player Tools menu, click Save Preferences.

The eBUS Player preferences, including the Communication control options, are saved.

The Device control settings and the Image stream control settings are not saved when you click Save 

Preferences. The Device control settings can be saved as part of the device “user sets”. For more 

information, see “Saving Your Device Configuration Settings to the Device’s Flash Memory” on page 55. If 

the Image stream control settings do not meet your needs, you must configure them every time you 

connect to a device.

You can revert back to the original eBUS Player default preferences by clicking Restore Default 

Preferences on the Tools menu.

Saving Your Device Configuration Settings to the Device’s 

Flash Memory

The changes that you make to your device are temporary and will not be persisted across power cycles. 

To save the changes to the device, you can use the options available in the UserSetControl section of the 

Device Control dialog box. Once saved, the changes (saved as “User Sets”) can persist across power cycles. 

Most iPORT devices support two User Sets: UserSet1, which consists of the user-configured settings, and 

Default, which consists of the pre-configured settings, to which you can always revert. Settings identified 

as Default in the Device Control dialog box cannot be changed.

The following table describes the options available in UserSetControl.

Table 10: Saving Configuration Settings to a GigE Vision or USB3 Vision Device

Setting Description

UserSetSelector Selects the User Set to load or save.

UserSetLoad Loads the User Set specified by UserSetSelector to the device and 

makes it active.

UserSetSave Saves configuration data to the User Set specified by UserSetSelector, 

which is part of the non-volatile memory of the device.
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To save a configuration change to UserSet1

1. In the Device Control dialog box, make the required configuration changes.

2. Scroll to the UserSetControl section and change the UserSetSelector setting to UserSet1.

3. Click UserSetSave.

To load the default configuration settings (one-time)

1. In the UserSetControl section of the Device Control dialog box, select Default in the 
UserSetSelector box.

2. Click the UserSetLoad setting and then click the UserSetLoad button that appears to the right.

The default settings are applied to the GigE Vision or USB3 Vision device.

To specify the persistent settings that are loaded every time the device is reset

� In the UserSetControl section of the Device Control dialog box, select a User Set in the 
UserSetDefaultSelector box and then close the Device Control dialog box.

The next time the GigE Vision or USB3 Vision device is reset, the User Set that you selected is 
loaded. 

UserSetDefaultSelector Selects the User Set to load and make active when the device is reset.

UserSetLoadLastUserSet Shows the last User Set executed by the device from a UserSetLoad 

command, or as a result of a reset of the device.

UserSetLoadStatus Indicates the success or failure of the last User Set applied. The User 

Set can be applied through a power cycle or through user selection.

Table 10: Saving Configuration Settings to a GigE Vision or USB3 Vision Device

Setting Description
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Chapter 7

Technical Support

On the Pleora Support Center, you can:

� Download the latest software.

� Log a support issue.

� View documentation for current and past releases.

� Browse for solutions to problems other customers have encountered.

� Get presentations and application notes.

� Get the latest news and information about our products.

� Decide which of Pleora’s products work best for you.

To visit the Pleora Support Center

� Go to www.pleora.com and click Support Center.

If you have not registered yet, you are prompted to register.

Accounts are usually validated within one business day.

http://www.pleora.com
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